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Welcome to InFOREMAX 
InFOREMAX is a return material authorization (RMA) software application that 

tracks product returns and repair estimates for service and manufacturing 

companies.  

 

InFOREMAX tracks all steps of the return process, from initializing return tickets 

to completing repair details. When customers require replacement items to be 

sent in advance, InFOREMAX also helps you track those items. InFOREMAX not 

only provides the ability to track your customer RMA, but also it helps you to 

track your supplier RMA by tracking items returned to your suppliers for 

replacement or repair. 

 

Unlike other RMA solutions, InFOREMAX allows you to assign specific parts to 

particular customers. As a result, you can manage different customers with their 

own unique parts lists. InFOREMAX also monitors RMA due dates and spare-

part stock levels issuing a desktop alert whenever an RMA is overdue or a spare 

part falls below a pre-determined minimum stock level.  

 

InFOREMAX stores the estimated cost and details of a repair. The software 

generates reports that can be used by management to assist the decision 

making process. These reports can range from the simple (product failure and 

RMA turnaround time analysis) to the complex (profitability and repair cost 

analysis). 

 

Thanks to its custom fields and data import/export capabilities, InFOREMAX is 

fast and easy to deploy and configure. 
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Understanding InFOREMAX Main Screen 
After you log into InFOREMAX, the main screen is displayed (see figure 1) and a 

desktop alert appears for overdue RMA (see figure 2).  This is your primary 

interface when using the InFOREMAX solution. 

 
 
 
 
 
 
 

 
 

 

 

 
 
 
 
 
 
 
 
 

Active RMA Statistics 
Displays statistics in graphical format, showing the 
percentage of returns in each priority category, number 
of returns and their status, and overall RMA volume for 
the last six months. 

Figure 1 Startup Page 
The startup page provide all 
in one graphical access to 
the main functions of the 
InFOREMAX toolkit. 

Main Navigation Pane 
These buttons are used to  
add, view, or edit/modify 
data or to view reports. 

Main Menu Options 
Click on menu items to view 
submenu options or use the 
toolbar buttons for quick 
access to popular functions. 

Status Bar 
Show current user’s name 
and role. 

Figure 2 

Desktop Alert 
Warning messages appear 
to notify the active user of 
an overdue RMA or under-
stocked spare part. 

Alert Details 
Click on this link to view 
detailed information. 
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About Main Toolbar 
The Main toolbar provides quick access to common commands  (See 
figure 3).  
 

 
 
 
There are several types of command buttons in the Main toolbar.  
 

 New RMA – Open an RMA Request Form in add mode. 
 

 Open Database – Open a database file. 
 

 Calendar – Open a Calendar Form. 
 

 Track RMA by Item – Open the Track RMA by Item Form. 
This Form allows you to search RMA using the information 
about faulty items such as serial number, failure description, 
etc. 
 

 Overdue RMA – Open a Form that displays a currently 
overdue RMA. 
 

 Under-stock Parts – Open a Form that displays a spare 
part that is currently below its minimal stock level. 
 

 Web Browser – Open a web browser 
 

 Online Help Content – Access InFOREMAX online help 
content. 
 

 
 

Figure 3 
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Introducing InFOREMAX DataGrid 
InFOREMAX utilizes a DataGrid control to present a tabular view of information.  

There are several extensibility features built right into DataGrid that make 

working in the DataGrid productive and convenient. In this section you'll find 

information that will help you to better understand the key features and functions  

of the DataGrid control (See figure 4). 

 

 

 

 

 

 
 

 

 

 

 

Figure 4 

Quick Finder 
A list of predefined filters 
that assist the end user with 
RMA search. 

User Actions Toolbar 
Contain a row of buttons for 
performing common actions 
on the DataGrid. 

Outlook GroupBy 
Group rows with similar 
values together, similar to  
the way rows are displayed 
in Microsoft ® Outlook. 

Field Chooser 
Quickly hide or show 
columns right from the field 
chooser. 

Filtering 
Filter data as required by 
the end user. 

Sorting 
Click any column header to 
sort data in that column.  
Columns can be sorted on 
their own or with other 
columns. 
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About Outlook GroupBy 
The Outlook GroupBy allows you to create custom groupings of data. You 
can drag and drop column headers into the GroupBy Area.  DataGrid will 
automatically create a distinct list of values for the selected column.   Each 
distinct value becomes a parent row. The rows that are associated with 
each distinct value are then indented and displayed as child rows (See 
figure 5). 
 

 
 
 

Figure 5 
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About User Action toolbar 
The User Action toolbar contains a row of command buttons that allows 
you to perform certain actions on the DataGrid (See figure 6).  
 

 
 
 
There are several types of command buttons in the User Action toolbar:  
 

 New Record – Open a Form in add mode. 
 

 Edit Record – Open a Form in edit mode and populate it  
with the selected row in your DataGrid. 
 

 Delete Record – Delete the selected DataGrid row. 
 

 Print DataGrid – Print out your entire DataGrid. 
 

 Export DataGrid – Export your data directly to Microsoft® 
Excel®. 
 

 Default Layout – Reset the DataGrid layout to default. 
 

 Column Chooser – Hide or show the Column Chooser. 
 

 
 

 

You can also use mouse right-click in DataGrid to bring up a context 
menu that contains a list of these commands. 

 
 
 

Figure 6 
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Introducing InFOREMAX Calendar 
InFOREMAX uses a Calendar display to present a work schedule of RMA. Use 

the calendar function to schedule repair work for your employees.  (See figure 7). 

 

 

 

 

 
 

 

 

 

 

Figure 7 

Select Week View or Month 
View to determine the level 
of detail displayed in the 
main Calendar window. 

Change the current calendar month 
by clicking the month scroll buttons. 
The bold text in the Calendar date 
indicates that a repair order exists for 
that date. 

Schedules for individual 
employees can be 
displayed by selecting the 
radio button beside their 
name. 

A tabular view of RMA data 
is provided for 
convenience. Open an 
RMA Form simply by 
double clicking  a row. 

The colored buttons display 
colors associated with 
different employees. 
Simply click the color button 
to open an RMA form. 
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Preparing InFOREMAX 
Before using InFOREMAX for the first time, you are required to add your 

company and user information and set certain parameters through the 

Preferences and Options.  

Company Information 
To modify the company information area, select the “Company 
Information” option in the “Tools” menu (See figure 8).  
 

 
  
 
Enter your company information and then click the “Save” button.  This 
information will be used when generating reports. 

Maintaining Users 
To maintain users, select the “Show All Users” option in the “Tools” menu 
(See figure 9). 
 

Figure 8 
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Delete a user – To delete a user, click on the user’s row and click the 
“Delete” button on the “User Action toolbar” or press the “Delete” key on 
your keyboard. 
 

 
You cannot delete the account of the currently logged-in user. 

 
 
Edit a user – You may change a value for an existing user in the “User 
Detail Form” (See figure 10). To open the “User Detail Form” for a 
particular user, select the desired row and click the “Edit” button on the 
“User Action toolbar” or simply double click the row.  
 

 
 
 
Click “Save” to save your changes or “Cancel” close the form without 
making any changes. 
 
Add a user – To add a user, click the “New” button on the “User Action 
toolbar” to bring up a New User Form.  
 
You may also open a New User Form by selecting File → New → Add 
User… 
 
 

 

Passwords are case-sensitive and must be upper or lower case letters 
or numbers and between 4-10 characters long. 

 

Figure 9 

Figure 10 
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Managing User Privileges and Roles 
To maintain user privileges and roles, select the “User Privileges” option in 
the “Tools” menu (See figure 11). 
 

 
 
 
By default the following three roles exist in the InFOREMAX database. 

Role Security Privileges 
Administrator  Full Permission 

 
Power User Read and Write Permission (excluding maintain 

users, view reports and change system setting.) 
 

Contributor Read and Write Permission on RMA data only. 
(cannot modify customer, parts, supplier 
employee information) 

   
Add a Role – To add a new role, right click any element in the “tree view” 
(left pane) to bring up a context menu and then select “New Role…”.  
 
Rename/Delete a Role – To rename or delete a role, select the role by 
clicking on it and then right click to bring up a context menu. Choose 
“Rename” from the context menu to change the name of the role or 
“Delete” to remove the role. 
 
 

 

You cannot not delete a role if it has already been assigned to a user. 
In addition, you cannot delete or rename the "ADMINISTRATOR" role 
or change administrator privileges. 

Figure 11 
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Preferences 
The Preferences section allows you to set master preference. To modify 
preferences, select the “Preferences…” option in the “Tools” menu (See 
figure 12).  
 

 
 
 
These are several sections under the Preferences: 
Auto-Generated RMA Number – Enable/disable auto-generated RMA 
number. You also have the option to add a prefix name followed by an 
auto-generated number.  
 
When this option is enabled, the application will automatically assign an 
RMA number in the following format:  
[RMA Prefix] + [YYYYDDMM of the Current Date] + [Auto Number] 
 
Customer-tied Spare Parts – Enable/disable customer-specific spare 
parts. When this option is enabled there are several things that happen in 
the application: 
 
1. On the Parts Detail Form, you may assign a specific part to a specific 

customer or to a group of customers.  
2. On the Data Import Form, you may import Parts–Customer data into 

the database. 
3. On the Data Export Form, you may export Parts–Customer data to 

an Excel spreadsheet. 
4. On the Customer RMA Form, you may select customer-specific 

spare parts. 
 

Figure 12 



16 16

 
Advanced Replacement RMA – Enable/disable the advanced 
replacement RMA feature. When this option is enabled the “Add 
Advanced Replacement Item..” button will appear on the “User Action 
toolbar” in the RMA Request Form (See figure 13). 
 

 
 
 
Desktop Alert for overdue RMA – Enable/disable desktop alert for 
overdue RMA. When this option is enabled the application will issue a 
desktop alert whenever an RMA is overdue. Alerts generally appear when 
a user first logs on to the system. 
 
Desktop Alert for under-stock Spare Parts – Enable/disable desktop 
alert for under-stock spare parts. When this option is enabled the 
application will issue a desktop alert whenever a spare part falls below a 
minimum stock level. Alerts generally appear when a user first logs on to 
the system. 
 
Sales Tax Options – Enable/disable the Use Automatic Tax Calculation 
option in invoices. You also have the option to add the tax rate. The sales 
tax value is used on customer invoices. 

Options 
The Options section allows you to set configuration options. To modify the 
Options area, select the “Options…” item in the “Tools” menu (See figure 
14).  
 

 
 
 
 
 
 

Figure 13 

Figure 14 
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There are several items in Options section which allow you to configure 
things like RMA Notification, Fault Code, and Custom Field Names. These 
options are defined below: 
 
RMA Notification – This table includes a list of specific email addresses 
that will be used for sending notification messages. The “Send 
Notification” feature can be found on the RMA Request Form. 
 
Fault Code – This lookup table converts the value of a fault code to a 
more user-friendly description. This helps you determine the reason for a 
product failure. It is highly recommended that you create a list of potential 
failure reasons for your products. The fault code is used on the product 
failure analysis report. 
 

 

You cannot not delete a fault code that has already been used in repair 
reports. To stop an obsolete fault code from appearing in the list, make 
the fault code inactive instead. 

 
 
Custom Field Name – Custom fields enable you to include extra 
information for your business information. You may set up new custom 
fields in Customer, Parts, Supplier and Employee Form.  You may create 
a text, numerical, or date custom field. To enable a custom field you need 
to make the field visible (See figure 15).  
 

 
 Figure 15 
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Adding Your Business Information 
Before start using InFOREMAX you are required to add your business 

information to the system. This information includes your customers, suppliers, 

parts and employees information. This data is required when you fill out an RMA 

Request Form. 

Customer Information 
To maintain customers, select the “Customers…” option in the “Edit” menu 
(See figure 16). You may also open a Customer DataGrid by clicking “Edit 
Customer” button on the Navigation Pane or on the Startup Page.  
 
 
 
 
 
 
 
 

 
 
 
You may add/modify your customer information on the Customer Detail 
Form (See figure 17). To save your changes, you must click the “Save” 
button.  
 

Figure 16 

Customer-tied Spare Parts 
When you assign spare parts to specific customers, the 
spare parts that are associated with each distinct customer 
are displayed as indented child rows beneath the 
customer’s entry. 
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Supplier Information 
To maintain suppliers, select the “Suppliers…” option in the “Edit” menu 
(See figure 18). You may also open a Supplier DataGrid by clicking the 
“Edit Supplier” button on the Navigation Pane or on the Startup Page.  
 

 
 

Figure 17 

Click the Email button to 
launch your default 
email application (e.g. 
MS Outlook) with the 
customer email address 
as a recipient. 

The spare parts that are 
associated with each 
distinct supplier are 
displayed as indented 
child rows beneath the 
supplier’s entry. 

Figure 18 
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You may add/modify your supplier information in Supplier Detail Form 
(See figure 19). To save your changes, you must click the “Save” button.  
 

 
 

Part Information 
To maintain parts, select the “Parts…” option in the “Edit” menu. See 
figure 20. You may also open a Parts DataGrid by clicking the “Edit Part” 
button on the Navigation Pane or on the Startup Page.  
 

 
 
 

Click the Website button 
to launch your default 
web browser (i.e. 
Internet Explorer) with 
the supplier’s URL. 

Figure 19 

Figure 20 

Part Number, Part 
Name, Unit Price and 
Unit Cost information 
are required for 
invoices, estimates, and 
cost analysis reports. 

InFOREMAX deducts 
the spare parts that are 
consumed in repairs 
from your inventories, 
and issues an alert 
whenever a spare part 
falls below minimum 
stock level. 
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You may add/modify your Part information in a Parts Detail Form (See 
figure 21). To save your changes, you must click the “Save” button.  
 

 
 

Employee Information 
To maintain employees, select the “Employees…” option in the “Edit” 
menu. See figure 22. You may also open an Employees DataGrid by 
clicking the “Edit Employee” button on the Navigation Pane or on the 
Startup Page.  
 

 
 

Figure 21 

Allows you to attach a 
picture of the spare part 
by clicking the “Upload” 
button.  

Assign a spare part to a 
specific supplier by 
adding the supplier to 
the suppliers list.  

Link a document or an 
image by clicking the 
“Attach” button in the 
User Action toolbar. 

Assign a spare part to a 
specific customer by 
adding the customer to 
the customer list.  

Figure 22 

Billing Information 
Technicians’ billing rate 
is required for invoices, 
estimates, and cost 
analysis reports. It is 
recommended that you 
provide this information. 
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You may add/modify your Employee information in an Employee Detail 
Form (See figure 23). To save your changes, you must click the “Save” 
button.  

 

 
 
 
 

 

You may use the Data Import Utility to import your business data into 
the application.  

 
 

Figure 23 

Custom Fields 
Allow you to add extra 
information for your 
employees.  
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Starting an RMA Request 
Generally, a new RMA ticket is created when a customer calls about returning a 

product for repair.  During the initial call, you collect all the customer information 

and then issue an RMA number to your customer with instructions for return of 

the defective product.  The customer will then send in the product with the RMA 

number. The following paragraph illustrates how InFOREMAX can assist you to 

start an RMA request in an efficient manner. 

Entering customer contact information 
To create a new RMA request, click on the “New RMA” button on the 
Navigation Pane, the Startup Page, or the Main Toolbar.  
 
A New RMA Request Form is displayed. 
 
To begin, add customer contact information by selecting a customer from 
the “Search By” combo box (See figure 24). 
 

 
 
 
 
If the customer does not exist in the “Search By” combo box and you need 
to create a new one, click on the “New” button in the User Action toolbar 
and select “Add Customer…” (See figure 25).   
 

Figure 24 

When you select a 
customer from the 
“Search By” Combo box, 
the contact information 
of that customer will be 
copied into the 
Customer box in the 
RMA Request Form. 
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After clicking on the “Add Customer…” button, a New Customer Form is 
displayed. 
 
After you complete the New Customer Form, the customer information will 
be added to the database. From that point, you will be able to select that 
customer from the “Search By” combo box. 

Entering RMA request details 
After you select a customer, you will need to fill in the details of this 
request in a New RMA Request Form (See figure 26).  
 

 
 
 
There are several input fields in a New RMA Request Form: 
 
1. RMA Number – This field allows user to enter an RMA number. If 

auto-generated RMA number is enabled, this field will be grey. 
2. Alternative Number – This field is optional. An Alternative Number 

may include an original purchase order number. 
3. General Description – A brief description of an RMA Request. 
4. Priority – There are four (4) RMA priorities:  Critical, High, Normal, 

and Low. This field allows users to set a priority level for an RMA. The 
default priority is set to Normal. 

 

Figure 25 

Figure 26 
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5. Status – There are six (6) RMA statuses:  Open, Issued, In-Progress, 
On-Hold, Closed and Cancelled. 

i. Open – The initial status of an RMA request is “Open”.  This 
indicates that an RMA request is created but the details are 
not complete. An RMA number has not been issued to the 
customer. 

ii. Issued – When the details are completed and an RMA number 
is issued to the customer, the status should be changed to 
“Issued” and an expected due date should be entered in the 
“Due Date” field. This indicates that a valid repair order exists 
in the system. 

iii. In-Progress – When the product has been received and 
moved to the repair area, the status should be changed from 
“Issued” to “In-Progress”. At this time, the work should be 
assigned to a specific employee and an actual due date 
should be entered in the “Due Date” field by a manager.   

iv. On-Hold – If the repair work needs to be temporarily 
suspended, the status should be changed to “On-Hold”. You 
may be waiting for a customer’s response or approval of repair 
estimates.  

v. Closed – When the repairs have been completed and the 
product is shipped back to the customer, the status should be 
changed from “In-Progress” to “Closed”.  Enter the date into 
the “Date Completed” field and change “Percentage of 
Complete” to 100%.  

vi. Cancelled – If the RMA request needs to be cancelled,  
change the status to “Cancelled”. 

 
6. Assign To – A person who is responsible at each step of the return 

process. 
7. Due Date – Enter an expected or actual due date of an RMA request. 
 

 

An expected due date indicates when a product should arrive the 
repair center.  After the product arrives, an actual due date may be 
entered to indicate when the repairs should be completed and the 
product shipped back to the customer. 

 
 
8. % Complete – This field indicates progress in an RMA request. 
9. Finish Date – The date that an RMA is completed. 
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10. Defective Merchandise  
i. Part Number and Name – These fields allow users to enter the 

name of a faulty product and its part number. These fields are 
combo boxes that contain a list of products. 

 

 

If customer-tie spare parts option is enabled, the part list will only show 
customer-specific spare parts 

 
ii. Quantity, Serial Number and Failure Description - allow users 

to enter the detailed information about the faulty products. 
iii. Warranty – This check box allows users to indicate whether an 

item is under warranty. 
iv. Advance Replacement – This check box allows users to 

indicate whether a replacement product should be sent to a 
customer in advance.  

v. Received and Date Received –  allow users to indicate 
whether the faulty products have been received. 

 
11. Notes – allows user to share messages with others.  Click on the 

“Notes” button on the User Action toolbar (See figure 27). The Date 
and User Name are appended to the note automatically.   The notes 
field has the ability to act as an activity log. 

12. Attachment – allows user to link documents or images to an RMA 
request. For example, pictures of a damaged product or product 
specification sheets.  To attach a file, click the “Attach” button in the 
User Action toolbar (See figure 27). 

 

 
 

Submitting an RMA Request  
After RMA request details have been entered, click the “Save” button to 
save your changes. 
 

 

If the auto-generated RMA number option is enabled, the application 
will automatically assign an RMA number for any new request. 

 
 
To send a notification email about an RMA request to the members of a 
group, click “Send Notification” check box at the bottom left of an RMA 
Request Form (See figure 28). 
 

Figure 27 
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With “Send Notification” enabled when you click the “Save” button, the 
application will launch your default email program with a predefined list of 
email addresses as recipients. The email message will contain information 
regarding this RMA request. 

Printing an RMA Request Worksheet 
To print an RMA request worksheet, click the “Print” button in the User 
Action toolbar and select “Print RMA Worksheet” (See figure 29). 
Appendix A shows a sample printout of an RMA Worksheet. 
 
Note: Before printing, click the “Save” button to save changes. 
 

 
 

Figure 28 

Figure 29 
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Working on an RMA Request 
Your company may offer products covered under a service contract agreement 

that includes an advanced replacement option. Advance replacement is a service 

that allows a customer to receive a replacement product prior to your company 

receiving the faulty item. If, after you have sent the replacement product, you 

receive the faulty item and determine that the defect is not covered by warranty, 

a repair cost estimate must be prepared and a Repair Quotation Form must be 

sent to the customer.  Prior approval must be obtained before proceeding with 

repairs.  In this section, you will learn how InFOREMAX can assist you in 

providing  advance replacement service and repair estimates in a timely and 

cost-effective manner. 

Adding Advanced Replacement Items 
Open an RMA Request Form where you will add advanced replacement 
items. 
 
To add an advanced replacement item, click on the “Add Advanced 
Replacement Item…” button on the User Action toolbar in the RMA 
Request Form (See figure 30).  
 

 
 
 

 

For the “Add Advanced Replacement Item...” button to appear, the 
advanced replacement option must be enabled. 

 

Figure 30 
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After clicking on the “Add Advanced Replacement Item…” button, an 
Advanced Replacement Form is displayed (See figure 31). 
 
 
 
 
 
 

 
 
 
After expanding a parent node, fill in details of the replacement item(s) in 
the child rows.  
 
There are several input fields in an Advanced Replacement RMA Form: 
 
1. Part Number and Name – allow users to enter the name of a 

replacement item and its part number. These fields are combo boxes 
that contain a list of products. 

2. Quantity – enter the quantity of the replacement item(s). 
3. Returned – This check box allow users to indicate whether the 

replacement product has been returned.  
4. Details – allows users to enter any extra information about the 

replacement item. 
 
 
 

Figure 31 

To display a child 
table, double click on a 
row that contains an 
expansion indicator.  

The defective items 
are displayed as 
parent bands.  
 

The replacement items that are 
associated with each defective 
item are displayed as child 
rows to each parent. 
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After the replacement item(s) have been entered, click the “Save” button 
to save changes. 
 
Printing an Advanced Replacement Form 
To print out an Advanced Replacement Form, click the “Print” button in the 
User Action toolbar and select “Print Advanced Replacement Form” (See 
figure 32). Appendix B shows a sample printout of an RMA Advanced 
Replacement Form. 
 
Note: Before you print, click the “Save” button to save changes. 
 

 
 
 

Creating a Repair Estimate 
To create a repair estimate, click on the “Repair Quotation” button on the 
Navigation Pane or the “Estimates” button on the Startup Page.  
 
You may also open a Repair Quotation Form by clicking “Create a Repair 
Quotation...” button on the User Action toolbar in the RMA Request Form 
(See figure 33). 
 

 
 
 

Figure 32 

Figure 33 
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A Repair Quotation Form is displayed  (See figure 34). 
 

 
 
 
 
To start a Repair Quotation Form, select an RMA from the “Search By” 
combo box. 

 
Entering a Repair Quotation Form 

1. From the “Part Name” or “Part Number” combo box, select a part for this 
repair quotation. “Unit Price” will automatically populate based on the 
selected part. 

2. Enter the “Quantity” of the selected part(s) for this repair quotation.  
3. Use additional lines if more parts are required for repairing this unit. 
4. Select an employee from the “Employee” combo box.  “Billing Rate” will 

automatically populate based on the selected employee. 
5. Enter the “Billable Hours” and “Comments” for this repair quotation. 
 
 

After completing the Repair Quotation Form, click “Save” to save changes. 
 

Figure 34 
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Printing a Repair Quotation Form 
To print a Repair Quotation Form, click the “Print” button in the User 
Action toolbar and select “Print Repair Quotation Form” (See figure 35). 
 
Note: Before printing, click the “Save” button to save changes.  
Appendix C shows a sample printout of a Repair Quotation Form. 
 

 
 
 

Figure 35 
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Completing an RMA  
After repair charge approval is obtained from a customer, repairs are performed.   

During the repair, parts and time used are recorded.  At a later date, a repair 

report and/or an invoice may be requested.   Following, are instructions on how 

to perform these tasks easily and efficiently with InFOREMAX. 

Entering a Repair Report 
To create a repair report, click on the “Repair Report” button on the 
Navigation Pane or the “Reports” button on the Startup Page.  
 
You may also open a Repair Report Form by clicking “Create a Repair 
Report...” button on the User Action toolbar in the RMA Request Form 
(See figure 36). 
 

 
 
 
A Repair Report Form is displayed (See figure 37). 
 
To start a Repair Report Form, you first select a RMA from the “Search 
By” combo box. 
 
 

Figure 36 
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Entering a repair report 

1. Select a part from the “Part Name” or “Part Number” combo box.  The 
“Unit Price” and “Unit Cost” (Hidden fields) will be automatically populated 
based on the selected part. 

2. Enter the “Quantity” of the selected part required to repair this product. 
3. Check the “Non-Warranty” box if applicable. 
4. Select a reason for product failure for this repair from the “Fault Code” 

combo box,  
5. Enter the number of items to be repaired in the “Fault Qty” field. (For 

example, if you need to repair 10 items with the same fault code, the 
“Fault Qty” would be 10.) 

6. Enter the “Repair Description”. 
7. Start another line if more parts are required for repairing this item. 
8. Select an employee to be assigned the repair from the “Employee” combo 

box.  “Billing Rate” will be automatically populate based on the predefined 
rate for the selected employee. 

9. Enter the “Billable Hours” for repairing this product. 
10. Enter “Comments” if applicable. 

Figure 37 
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After completing the repair report form, click the “Save” button to save 
your changes. 
 
Printing a Repair Report 
To print out a Repair Report, click the “Print” button on the User Action 
toolbar and select “Print Repair Report” (See figure 38). Appendix D 
shows a sample printout of a Repair Report. 
 
Note: Before you print, you must first click the “Save” button to save your 
changes. 
 

 
 
 
 
Printing an Invoice 
To print an Invoice, click the “Print” button on the User Action toolbar and 
select “Print Customer Invoice”. Appendix E shows a sample printout of a 
Customer Invoice. 
 
Note: Before you print, you must first click the “Save” button to save your 
changes. 
 
 

Figure 38 
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 Report and Data Analyzing  
As a manager, you are often required to create reports that summarize analysis 

results and show details about your repair center as well as your products. 

InFOREMAX can assist you to create comprehensive reports quickly and 

efficiently with a single click.  

Creating Comprehensive Reports 
InFOREMAX’s Reporting function is fully capable of generating analysis 
reports to meet any business needs. Three types of analysis are available: 
Profitability Analysis, Product Failure Analysis and Turnaround Time 
Analysis. 
 
To view one of the analysis reports, click on the “View Report” button on 
the Navigation Pane (See figure 39). You may also view an analysis report 
by clicking the “Analysis Report” submenu button under “Reports” on the 
main menu. 
 

 
  
 
An analysis dialog is displayed (See figure 40). This dialog allows you to 
choose a particular customer and specify the beginning and end dates for 
the report. 
 

 
 

Figure 39 

Figure 40 
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Understanding RMA Reports 
Profitability Analysis Report includes a profitability analysis (see 
figure 41) as well as a parts and labor cost analysis (see figure 42). 
 

 
 
 
Profitability Analysis includes a calculation of profitability ratios. 

 Gross Profit = Sales – Cost of Goods Sold 
 Operating Income = Gross Profit – Operating Expense 

 
 Gross Profit Margin = Gross Profit/Sales 
 Operating Profit Margin = Operating Income/Sales 

 
Gross Profit Margin – This ratio indicates how efficiently a business is 
using its materials and labor in the production process.  It shows the 
percentage of net sales remaining after subtracting the cost of goods sold.  
A high gross profit margin indicates that a business can make a 
reasonable profit on sales, as long as it keeps overhead costs in control. 
 
Operating Profit Margin – This ratio indicates the operational efficiency of 
the business giving a good indication of how much a company makes from 
each dollar of sales.  
 

Figure 41 
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Parts and Labor Cost Analysis identifies the total cost of material and 
labor used for WARRANTY and NON-WARRANTY repairs. The sales of 
Parts and Labor for non-warranty items are also determined. 
 
 

Figure 42 
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Product Failure Analysis Report includes a count of total defective 
materials (see figure 43) and a product failure analysis (see figure 44). 
 

 
 
 
Total Defective Materials identifies the total number of materials that have 
been serviced. 
 

 
 
 
Product Failure Analysis displays the reason for product failure to aid with 
future diagnostics and product reliability improvements. 
 

Figure 43 

Figure 44 
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RMA Turnaround Time Analysis Report includes average RMA 
turnaround time analysis (see figure 45) and Completed RMA cases 
review (see figure 46). 
 

 
 
 
Turnaround Time Analysis identifies performance gaps in your service 
department. Results include the top 10 customers who have the longest 
RMA turnaround time. 
 
 

 
 
 
Completed RMA Cases Review summarizes the RMA cases that occur 
between the specific start and end date. 
 

Figure 45 

Figure 46 
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Other Features 
This section covers other valuable features of the InFOREMAX system.  

Data Import/Export Utility 
InFOREMAX’s Import-Export is a complementary utility that allows you to 
write data into and out of your InFOREMAX database. This utility can 
import external spreadsheet data into the database and export database 
data to spreadsheet files. This can save hours of data entry time!  
 
The Excel templates used for importing data are present in the 
InFOREMAX...\Excel folder.  
 
There is no specific sequence for importing spreadsheet data into the 
database but there are several rules you need to follow. 
1. The column marked with an asterisk (*) indicates that it is a required 

field. 
2. Names are case-sensitive. InFOREMAX ≠ inforemax. 
3. When you import “parts_suppliers” or “parts_customers” data, the 

name of parts, suppliers and customers must be identical to the one in 
the part, supplier and customer tables. Otherwise, the utility will add a 
new entry in the corresponding tables if no match is found. 

 
To start Import-Export Utility, select the “Data → Import-Export” submenu 
under “Tools” 
 
Synchronizing you data with the data in your InFOREMAX database 
By selecting the overwrite existing record option, you are able to 
synchronize your spreadsheet data with the data in your InFOREMAX 
database given that their names are identical (See figure 47). 
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Data Recovery Utility 
InFOREMAX’s Data Recovery is a complementary utility that allows you to 
restore data that is deleted by other users. This utility is fully capable of 
recovering data lost after accidental deletion. It allows you to recover data 
in the Customer RMA, Customer, Supplier RMA, Supplier, Parts, 
Employee, and User tables. 
 
To start the Data Recovery Utility, select the “Data →  Recovery” 
submenu under “Tools”.  

View License Information 
This utility provides you with the general information about your software 
subscription. You can find your SaaS period and its expiration date (See 
figure 48). 
 

 
 
 

Figure 47 

Figure 48 
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You can switch your subscription plan to premium by reactivating your 
application with a different serial number 

InFOREMAX Online 
We back our products with a 30-Day Money-Back Guarantee and free 
lifetime upgrades. If you find any issues or bugs in the application or have 
any questions or suggestions, you can send us a message by using our 
online forms. 
 
If you find any software bug, we will fix it for you and provide a software 
update to you for free! 
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Appendices  

Appendix A: A Sample Printout of an RMA Worksheet 
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Appendix B: A Sample Printout of an RMA Advanced Replacement Form 
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Appendix C: A Sample Printout of a Repair Quotation Form 
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Appendix D: A Sample Printout of a Repair Report 
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Appendix E: A Sample Printout of a Customer Invoice 
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Appendix F: Spreadsheet Data Specification 
 

Customer Table 

Field Name Date Type Max Length 

Customer Number Text 30 

Customer Name* Text 100 

Job Title Text 50 

First Name Text 50 

Last Name Text 50 

Email Text 250 

Phone Number Text 30 

Fax Number Text 30 

Billing Address Text 250 

Billing City Text 50 

Billing State Text 50 

Billing Zip Text 20 

Billing Country Text 50 

Shipping Address Text 250 

Shipping City Text 50 

Shipping State Text 50 

Shipping Zip Text 20 

Shipping Country Text 50 

usrdefdate1 - 5 Date/Time MM/DD/YYYY 

usrdefnumber1 - 5 decimal(15, 2)  

usrdeftext1 - 5 Text 100 
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Supplier Table 

Field Name Date Type Max Length 

Supplier Number Text 30 

Supplier Name* Text 100 

Email Text 250 

Website Text 255 

Contact Name Text 50 

Phone Number Text 30 

Fax Number Text 30 

Address Text 250 

City Text 50 

State Text 50 

Zip Text 20 

Country Text 50 

usrdefdate1 - 5 Date/Time MM/DD/YYYY 

usrdefnumber1 - 5 decimal(15, 2)  

usrdeftext1 - 5 Text 100 
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Parts Table 

Field Name Date Type Max Length 

Part Number Text 30 

Part Name* Text 50 

Description Text 100 

Alt Number Text 30 

UOM Text 10 

Cost decimal(15, 2)  

Price decimal(15, 2)  

Qty Integer  

Minimum Stock Integer  

usrdefdate1 - 5 Date/Time MM/DD/YYYY 

usrdefnumber1 - 5 decimal(15, 2)  

usrdeftext1 - 5 Text 100 
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Employee Table 

Field Name Date Type Max Length 

Last Name* Text 50 

First name* Text 50 

Title Text 50 

Email Text 250 

Billing Rate decimal(15, 2)  

Phone Number Text 30 

Address Text 250 

City Text 50 

State Text 50 

Zip Text 20 

Country Text 50 

usrdefdate1 - 5 Date/Time MM/DD/YYYY 

usrdefnumber1 - 5 decimal(15, 2)  

usrdeftext1 - 5 Text 100 

 

 

 


